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What is Microbial Genetics Construction Kit?

Microbial Genetics Construction Kit (µGCK) is a simulation of a microbial genetics
laboratory.  It provides you with a set of unknown bacteria on a petri plate or in a test
tube.  You can then investigate many of the characteristics of these bacteria using tools
similar to those used in a real laboratory.  µGCK is not meant to replace  work with real
organisms.  But the constraints of time, space, money, and unskilled laboratory
technique, important parts of real scientific research, make it practically impossible for
most students to experience the excitement and challenge of a real research problem.
µGCK can give you the chance to work with problems that have the real surprise and
real complexity that make scientific research a fascinating activity.  We have tried in this
program to let you tackle realistic problems in a way similar to that used in real
scientific research.  You or your instructor however, can set up µGCK so you can start
with a simplified world, and add new material as your understanding grows.
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What You Should Read

If you are unfamiliar with the Macintosh computer.
Read the separate document: BioQUEST: Macintosh Fundamentals

If you want to know whether or not you have the right equipment to run the
program.

Read the Appendix entitled: Hardware and Software Requirements (p. 74 ).

If you are familiar with the Macintosh but not with this program.
Read one of the sections entitled: A Tour of X with µGCK,  although most of these
can be read independently, it is best to read each of them in order while working with
the program at the same time..

If you've  been through the Tours of µGCK and want more details.
Read the section entitled: Reference (p. 37).

If you started by skimming the manual but have found something that doesn't
seem right.

Read the section entitled: A Word of Warning (p. 4 ), the appendix entitled It
Doesn't Work!(p. 73 ), or consult the index(p. 75).

If you are a veteran user of the program and want to know what is different
about this version.

Read the separate document entitled: µGCK Version History.
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What You Need to Know

We assume that you are already familiar with the basic set of standard Macintosh terms
and operations.  If you are not comfortable with these, you should read BioQUEST:
Macintosh Fundamentals  or another introduction to the Macintosh before you begin.
Better yet, find someone who knows what she is doing, show her this list of words and
ask her to explain what each of them means.  The terms you need to be familiar with
are: window, menu, mouse, point, click, shift click, drag, and double click.   If you
understand these, you are ready to get started.  Before long, however, you will also
need to know several more Macintosh vocabulary words: close box, zoom box, grow
box, title bar, scroll bar, clipboard, and desk accessory.

We also assume that you know how to start a program.  If you think you know how,
but you experience some difficulty, look at the Appendix entitled, It Doesn't Work! for
suggestions that we hope will help.
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A Word of Warning

It is possible that what you read in this manual may not accurately reflect what you see
on the screen as you use the program.  There are two basic reasons for this.  First,
µGCK is not yet a final product. It is changing as we improve it and add new
capabilities.  The manual you are reading may have been written to go with a different
version of the program than the one you are using.  If you suspect that this may be the
case, refer to the Appendix entitled It Doesn't Work!.  It will tell you how to check for
this problem.

The second reason for a conflict between the manual and the program is intrinsic to the
design of µGCK itself.  We have tried to make µGCK a flexible program so that it can
be adapted to fit the needs of many situations.  We feel that this is a good thing, but it
makes describing the program a bit difficult.

There are several differences that may be due to customization of the program:
• The menus we describe here may be different from yours.  In particular, it

is possible that a menu operation that we describe may be missing in your
problem.  We strongly recommend that you use the version of µGCK
with the tour problems and use the problem appropriate to the tour you
are reading so you won't run into this.

• The genetic organization of the bacterial species will be different every
time you run the program.

• The set of nutrients and antibiotics used may be different.  At the moment
you cannot change this yourself but we have built two versions of µGCK,
one with a long list of nutrients and one with a short list.  Eventually you
will be able to change this yourself.
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Getting Started

Starting the Program

To start the program, double click  on the µGCK program icon (see Figure 1).

Figure 1.  The µGCK  program icon

The next thing you see will be a list of problems such as that shown in Figure 2.   If you
are taking the first tour, Serial Dilution, you will want to choose the first problem.

Choosing a Problem

Figure 2. Selecting a µGCK problem.

To choose a problem, click on it to highlight it in black (like Serial Dilution Tour in
Figure 2), then click on Start Problem.  If you don't have exactly this list of problems,
choose one that seems similar to one of those listed.
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If you click on the button labeled Cancel instead of Start Problem, µGCK will stop
running.

Once you have selected a problem, proceed to the section describing the closest tour.
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A Tour of Serial Dilution with µGCK

The Field Tube

You should see a picture of a test tube like that shown in Figure 3.  This test tube is filled
with an unknown number of bacteria of unknown phenotype and genetic makeup.
The test tube is referred to as the Field Tube because it represents a set of bacteria
collected from the field.  In this tour of serial dilution, we will look only at the number
of bacteria; the bacterial phenotypes and genetic makeup will be examined elsewhere.

The critical thing to note about this test tube is that it is light gray.  This indicates that
the tube is turbid.  It has enough bacteria in it to scatter light.  Soon we will see tubes
that are  clear indicating that they have far fewer bacteria.

Figure 3. A field tube.

Serial dilution is a process of preparing increasingly dilute populations of bacteria until
the population is small enough to be counted by hand.  Individual bacteria can't be
counted easily because they can't be seen.  An easy way to count bacteria is to put them
on a petri plate, let them grow and count the colonies that result from the individual
bacteria.  If there are too many bacteria, this will not work because we won't be able to
tell which colonies result from which individual bacteria.  If there are only a few bacteria
on the plate, however, there will only be a few colonies and we can tell how many
individual bacteria were on the plate before the growth.

In order to do this we need to be able to put the bacteria that are in a tube on a petri
plate and let them grow.  This is called plating a tube.
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Plating a Tube

Get Some Help

Figure 4. The Tube menu.

In Figure 4 the Tube menu has been pulled down.  You can see that the menu itself and
all of the menu items are gray.  A menu is gray if all of its items are gray and a menu
item is gray if it won't do anything.  A gray menu or menu item is usually called
inactive.

In µGCK, if you try to choose an inactive menu item, you will be shown a short
message explaining why the item is inactive and how to make it active.

To try this, pull down the Tube menu and try to choose the Plate Tube on Tube
Medium  menu item.

When you release  the mouse button, a window like that in Figure 5 will appear.  To see
the remaining text move the mouse pointer over the downward pointing arrow and
click.  To dismiss the help message, click on the Cancel  button.

Figure 5.  A message describing why Plate Tube on Tube Medium is gray.

The message in Figure 5 tells us that we need to select a test tube before we can plate it.
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Select the Tube
To select the tube, move the mouse pointer over the body of the tube and click.  A
selected tube's title is highlighted in black (see Figure 6).  To unselect the tube, click on it
again.  For the moment, however, it should be selected, so make sure that it looks like
Figure 6.

Figure 6.  A selected tube.

Plate the Tube on Tube Media
After you have selected a tube, when you pull down the Tube menu the Plate Tube
menu option will be black to indicate that it is active.  Choose this menu option and
µGCK will spread the contents of the tube on a new petri dish, incubate the dish to
grow all the individual bacteria into colonies, and then display the plate.  The nutritional
medium used for the plate will be the same as that in the tube.

Figure 7.  A petri dish with a bacterial lawn.

Figure 7 is the result of plating the field tube.  The gray material in the petri dish is a
mass of bacteria.  In this case, so many bacteria were placed on the plate that when they
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incubated and grew, the resulting colonies overlapped and no separate colonies are
visible.  This kind of plate, with no distinct colonies, is called a lawn plate.

Diluting a Tube

In order to have countable colonies on a plate after we plate a tube, we need to lower
the concentration of bacteria in the tube before plating.  We do this by repeatedly
diluting the tube until we get discrete colonies when we plate.

To dilute a tube, select it and choose the Dilute 10 Fold  option from the Tube menu.
This removes one tenth of the liquid in the selected tube and adds it to a new tube nine
tenths full of sterile water.  The result is that the population of bacteria in the second
tube is one tenth as dense as it was in the first tube.  Notice that the diluted tube is not
turbid (gray) indicating its lower population density.

Figure 8 shows the tube resulting from one dilution of the field tube.  Its relative
population density is indicated at the bottom by the .1.  It is automatically selected for
you so that you can easily dilute it further or plate it to see if the population is sparse
enough yet.

Figure 8. A ten fold dilution of the field tube.
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Counting Colonies

Figure 9. Plate from a tube with a million-fold dilution.

Figure 9 is a plate produced from a tube that was diluted 6 times for a population
density a million times lower than that of the original field tube (remember that your
bacterial population will be different).  Plating this tube lowered the number of bacteria
by another factor of ten since one tenth of the tube's volume was put on the plate.
Since there are 35 colonies, our first approximation of the population in the field tube is
350 million bacteria (35 times 10 times 106.

Once you have a diluted tube that yields a countable number of colonies, plate it several
times and compare the results.  Try diluting it again and then plating it.

Cleaning up

Depending on how you chose to do things you probably have eight or nine tubes and
five or six plates by this time, and the screen is getting pretty crowded.  µGCK provides
a number of aids help clean things up.

Rearranging Plates and Tubes
Petri plates and test tubes are normal Macintosh windows and you can drag them just
as you drag most other windows.  This is a way to manually clean things up.

Shrinking Plates and Tubes
Most of the plates and tubes you produced during the preceding exercise aren't
intrinsically very interesting.  You can shrink (close) them to get them out of the way
and concentrate on the interesting ones.  To close a plate or tube, click in the white box
in the upper left-hand corner of the window (the mouse arrow is in the close box in
Figure 9).  Figure 10 shows icon versions of a plate  and a field tube.
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Figure 10. Icon forms of a test tube and a petri dish.

To re-expand (open) one of these icons, double click on it.

Asking µGCK
You can also ask µGCK to clean things up for you.  Choose Clean Up  on the Utilities
menu and µGCK will move all windows  back to where they first appeared.

Quitting

This is the end of the tour of Serial Dilution.  If you want to quit at this point, you can do
so by choosing the Quit  item from the File menu.  You will be asked if you want to
save your work.  If you decide not to quit after all, click on the Cancel  button.  If you
save your work, the section in the reference section entitled Opening a Saved Problem
will tell you how to restore the problem to where you left it.

If you want more detail on using tubes and plates, read the relevant sections of the
Reference section.

If you want a taste of some of the other things that µGCK can do, read the following
Tour sections.

If you want details on exactly how the computer simulates various aspects of serial
dilution, read the How µGCK Works section.
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A Tour of Phenotype Identification with µGCK

This is a tour of phenotype identification with µGCK.  If you just finished a different
tour, you can choose New Problem  from the File menu to start a new problem.  This is
equivalent to starting the program over again.

The Field Plate

You should see a picture of a petri plate similar to that shown in Figure 11.  You will
have a different number of colonies in different places, however, so yours will not be
identical to Figure 11.

Figure 11.  A field plate.

Figure 11 shows a field plate.    Each of the gray circles represents one colony.  The idea
is that the colonies shown on the plate were grown from bacteria collected from the
field and are presented here for your analysis.  The  colonies are of unknown genotype
and phenotype, although all bacteria within a colony share a genotype and phenotype.

The letters along the left side and the numbers along the bottom of the plate form a
grid that is used to name the colonies.  The single colony in the top row, for example, is
referred to as colony A4.  To make the grid easier to read you can draw all the grid lines
by clicking on the grid button which  is the set of cross hatched lines in the upper right
hand corner of the window.  In Figure 12 the mouse arrow is shown over the grid
button.
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Figure 12.  A gridded plate.  The mouse arrow is over the grid button.

Figure 12 shows a plate after the grid has been turned on.  To turn the grid back off,
click on the grid button again.

Replica Plating

Replica plating is a method of copying bacteria from one plate to another plate while
maintaining the relative positions of colonies.  By changing the growth media used on
the new plates you can infer colonies'  nutritional requirements.

Get some Help

Figure 13. The Plate menu.

When you pull down the Plate menu you will see something that looks like Figure 13.
You can see that all items on the menu are gray to indicate that they are inactive.  If you
try to select an inactive menu item in µGCK it will tell you why the menu item is
inactive.

To try this, release the mouse button when it is over the Replicate  item and you will
see something like Figure 14.   To see the remaining text move the mouse pointer over
the downward pointing arrow and click.  To dismiss the help message, click on the
Cancel  button.
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Figure 14. A help message explaining  why  the Replicate  menu item is inactive.

Select a Plate

This message tells you that you must select  a plate before you can replicate it.  To do so,
click somewhere on the plate other than where there is a colony or a button.  Clicking
on the plate's title works well.  A selected plate's title is printed in white on black instead
of the normal black on white.  Figure 15 shows a selected plate.

Figure 15.  A selected plate.  Note that the title is highlighted in black to indicate selection.

Once you have a selected a plate you can choose the Replicate item from the Plate
menu.

Select a Medium

Now you have to decide what medium you want to be used for the new plate.  µGCK
will display a Media Matrix  that allows you to specify what you want on the new plate.
Figure 16 is an example of such a media matrix.
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Figure 16.  A choose medium media matrix for replica plating.

This media matrix shows you the media used in all previous plates and test tubes and
allows you to choose the ingredients for your new medium.  In the example shown
here, there has been only one previous plate, the field plate.  Its medium has all
nutrients and no antibiotics.  This is shown in the second column of the matrix by the
filled cells in each of the nutrient rows and the empty cells in the antibiotic rows (the
two bottom rows).

The name at the top of the first row in the matrix, "Plate 2", is the name of the new plate
and the column under it shows  its medium.  Initially the medium has no nutrients and
no antibiotics.  You can add nutrients or antibiotics by clicking in the corresponding
cells.  The mouse arrow in figure 16 is over the cell corresponding to the nutrient
alanine; clicking here would add alanine to the medium for plate 2.
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Figure 17.  The medium for plate 2 has no antibiotics and all nutrients except for alanine.

The four lower buttons on the left are shortcuts.  If you click on the top button, All
Nutrients, it will fill in all the nutritional ingredients.  Invert Nutrients  will make the
nutritional medium the opposite of what it is before the button is pressed.  Clear
Nutrients  will remove all nutrients from the medium, and Clear Antibiotics  will remove
all antibiotics.  These are particularly useful when there is a larger set of nutritional and
antibiotic factors than in this example.

The medium shown for plate 2 in Figure 17 was created by clicking on All Nutrients  and
then clicking on the alanine square to remove alanine.

Plate

When you have created the medium for your replica plate, click on the Plate button to
create the new plate.  The Cancel  button would cancel the replica plating and no new
plate would be created.  Figure 18 shows the original field plate next to the new replica
plate.
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Figure 18 .  The field plate and a replica side by side.

By comparing the two plates we can tell which colonies require alanine to grow (alanine
auxotrophs) and which do not (alanine prototrophs).  Colony A4, for example, did not
require alanine to grow, so we know that it is prototrophic for alanine.  B3 and B5, on
the other hand, did not grow without alanine, so they are auxotrophic.

Checking the Medium

It's easy to forget  where a plate came from so µGCK provides some tools to remind
you of what you have done.

First, you can ask to the history of a plate by selecting the plate and choosing Plate
History  from the Plate menu.  For Plate 2, this gives the information shown in Figure
19.

Figure 19. A plate history  notepad.

Plate History tells you that plate 2 is a replica of the field plate but it does not give you
any information about the medium used in plate 2.  This information is available in the
media matrix.  To open the media matrix choose Media Matrix  from the Analysis
menu.
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Figure 20.  The media matrix displays the media used by all plates and tubes.

The media matrix shown in Figure 20 gives the additional information that the medium
used for plate 2 was deficient in alanine.

Recording the Results

Remembering  all of these pieces of information and reporting them to others is quite a
chore, so µGCK provides a standard way to record and present colony phenotype
information in the phenotype worksheet.

Open a Phenotype Worksheet

To open a phenotype worksheet choose the Phenotype Worksheet  item from the
Analysis menu.    Figure 21 shows a phenotype worksheet.

Figure 21.  A phenotype worksheet.  This one has been resized to show  all nutrients and all colonies.



20   Microbial Genetics Construction Kit User Manual

Using the phenotype worksheet is somewhat similar to using the media matrix you
have already seen.  Nutrients and antibiotics are listed down the left side and the
colonies on the field plate are listed along the top.  At the intersection of each nutrient
row with each colony column is a cell where the relationship between the two can be
recorded.  A question mark (?) indicates that the relationship is unknown.  Click on a
cell to cycle through its possible states.

In this example we want to record that colony A4 is an alanine prototroph and B3 and
B5 are alanine auxotrophs.  Auxotrophy is conventionally shown with a minus sign (-)
and prototrophy is shown by a plus sign (+), so these are the possible states of the
nutrient cells of a phenotype worksheet.  Figure 22 shows the phenotype worksheet
with the indicated information recorded.  This information is recorded by clicking once
on the (alanine:A4 )cell to make it a plus sign, and clicking twice on the (alanine:B3) and
(alanine:B5) cells to change them to minus signs.  This will not work in this example
because this worksheet has been locked to prevent accidental changes.  You can unlock a
worksheet by clicking on the padlock button ( )  in the upper left corner of the
window.  To relock, click again.

If we were recording antibiotic resistance, we would click in the antibiotic rows at the
bottom of the worksheet to switch between r (resistant), s (sensitive), and ? (unknown).

Figure 22.  A phenotype worksheet with the alanine status of colonies A4, B4, and B5.

Close the Worksheet
To close the worksheet, click in the close box in the upper left corner.  The worksheet
will collapse to a small icon (see figure 23).  You can re-expand the worksheet by double
clicking on the icon or by re-choosing the Phenotype Worksheet  item on the Plate
menu.
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Figure 23.  A collapsed phenotype worksheet.

Quitting

This is the end of the tour of Phenotype Identification.  If you want to quit at this point,
you can do so by choosing the Quit  item from the File menu.  You will be asked if you
want to save your work.   If you decide not to quit after all, click on the Cancel  button.
If you save your work, the section in the reference section entitled Opening a Saved
Problem will tell you how to restore the problem to where you left it.

If you want more detail on using  plates and phenotype worksheets, read the relevant
sections of the Reference section.

If you want a taste of some of the other things that µGCK can do, read the other Tour
sections.

If you want details on exactly how the computer simulates various aspects of replica
plating, read the How µGCK Works section.
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A Tour of Complementation Testing with µGCK

This is a tour of complementation testing with µGCK.  If you just finished a different
tour, you can choose New Problem  from the File menu to start a new problem.  This is
equivalent to starting the program over again.

The Field Plate

You should see a picture of a petri plate similar to that shown in Figure 24.  You will
have a different number of colonies in different places, however,  so yours will not be
identical to figure 24.

Figure 24.  A field plate.

Figure 24 shows a field plate.    Each of the gray circles represents one colony.  The idea
is that the colonies shown on the plate were grown from bacteria collected from the
field and are presented here for your analysis.  The  colonies are of unknown genotype
and phenotype, although all bacteria within a colony share a genotype and phenotype.

The letters along the left side and the numbers along the bottom of the plate form a
grid that is used to name the colonies.  The single colony in the top row, for example, is
referred to as colony A4.  To make the grid easier to read you can draw all the grid lines
by clicking on the grid button which is the set of cross hatched lines in the upper right
hand corner of the window.  In Figure 25 the mouse arrow is shown over the grid
button.
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Figure 25.  A gridded plate.  The mouse arrow is over the grid button.

Figure 25 shows a plate after the grid has been turned on.  To turn the grid back off,
click on the grid button again.

Looking at Colony Phenotypes

If you went through the previous tour (Phenotype Identification), you have experience
determining the phenotypes of colonies and recording them in a phenotype worksheet.
In this tour we are going to look at complementation effects that require that we
already know the phenotypes of colonies.  The problem used in this tour has been set
up so that this work has already been done and the phenotype worksheet already filled
in.

To open the phenotype worksheet, pull down the Analysis menu and choose
Phenotype Worksheet (see Figure 26).

Figure 26.  The complete phenotype worksheet for the field plate.
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Remember that your phenotype worksheet won't look identical to this one because
your field plate is different.

The columns are labeled across the top with the names of colonies on the field plate.
The rows are labeled along the left side with the names of the available nutrients and
antibiotics. To find the relationship between a colony and a particular nutrient, look at
the cell at the intersection of the appropriate row and column.

Remember that a plus sign (+) indicates prototrophy, or that the colony does not
require that nutrient in order to grow.  A minus sign (-) indicates that the colony is
auxotrophic for the nutrient, so it requires it to grow.  For antibiotics, an r indicates
resistance and an s indicates sensitivity.

If you went through the previous tour you know that you can click on a worksheet cell
to change its contents.  This will not work in this example because this worksheet has
been locked to prevent accidental changes.  You can unlock a worksheet by clicking on
the padlock button ( )  in the upper left corner of the window.  To relock, click again.

Organizing the Phenotypes

We will be doing complementation testing between auxotrophs for the same nutrient
to see if their defects are sufficiently different that they complement each other.  For
our purposes then, nutrients for which we have few or no auxotrophic colonies are not
interesting.  It is nice in cases like this to be able to forget about the 'uninteresting'
nutrients and concentrate on those that are more immediately useful.

For this purpose, you can drag rows of the worksheet down to the bottom and then
resize the worksheet so that you don't even see the uninteresting rows.  To drag a row,
click on the name of the row and drag the dotted outline of the row down to the
bottom and release.  In Figure 27 we are about to drag the tyrosine row to the bottom.
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Figure 27.  The tyrosine row is about to be dragged down.  Note the dotted gray outline around the row.

Figure 28 shows the result of this procedure.  We have dragged tyrosine and biotin to
the bottom and used the window grow box to shrink the window so that the bottom
five rows are invisible.

Figure 28.  All the uninteresting nutrients were dragged to the bottom and the worksheet was resized to
exclude them.

You can also drag the columns of a worksheet by clicking on the colony names.  This is
useful if you want to concentrate on the auxotrophs for only one nutrient, drag them all
to the left, and shrink the window horizontally so that you needn't look at non-
auxotrophic colonies.

Testing for Cross Feeding

The kind of complementation described in this tour is complementation between
bacteria, not complementation between different genes within a bacterium.  These are
cases in which bacteria growing alone cannot synthesize a nutrient because of a defect
in the biochemical pathway, but when two or more bacteria grow together, they can
supply each other with necessary intermediates in the pathway and together can
synthesize the nutrient.  This variety of complementation is called cross feeding.
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To conduct a cross feeding test in µGCK , inoculate a test tube with bacteria from two
or more colonies.  If the test tube growth medium is lacking a nutrient that all the
bacteria require, there will be growth only if the bacteria can cross feed.

To select one colony, click on it.  To select two or more colonies, click on them while
holding down the shift key.  In Figure 29, I have selected the two colonies C4 and C6
(both auxotrophic for alanine).

Figure 29.  Colonies C4 and C6 have been selected by clicking  while holding the shift key.

Once you have selected the colonies you want to test, choose the Inoculate Tube in New
Medium  option on the Colony menu.  This will give you a chance to select the medium
you want in the new tube by showing you the media matrix (see Figure 30).
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Figure 30.  Choosing the medium for a new test tube.

Use the media matrix to select the medium for the new tube (Tube 1).  Click in the first
column to turn nutrients on and off.  If a cell is gray, the nutrient is included; if white,
the nutrient is not included.  In this example I want to test these two colonies for their
ability to grow without alanine, so I will create a medium with all nutrients except for
alanine.  I do this by clicking the All Nutrients  button to include all nutrients and then
click on the alanine cell to turn it off.

When you have set up the appropriate medium for your test (which will probably be
different from the example), click on the Inoculate  button to create and inoculate the
tube.
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Figure 31.  A test tube that is not turbid.  In this case that means that there was no growth.

 Test tubes with large populations of bacteria are turbid.  That is, they scatter light.  In
µGCK this is indicated by gray coloring.  Since the tube in Figure 31 is clear, we know
that there was no significant bacterial growth.   Colonies C4 and C6 did not cross feed.
They appear to have a common defective cistron in the alanine pathway.

Recording the Results

Complementation experiments generate a great deal of data that must be recorded and
manipulated to be useful.  µGCK provides complementation worksheets to help you
with this task.   To open one, choose Complementation Worksheet  from the Analysis
menu.

Since complementation relationships will be different for every nutrient, you need to
specify which to use.  Figure 32 shows how to select a nutrient.  Click on the name of
the nutrient you want  and click the OK  button.
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Figure 32. Choosing  a nutrient for a complementation worksheet.

The rows and columns of a complementation worksheet are both labeled with the
names of the colonies on the field plate.   The cells at the intersections of rows and
columns record whether or not the corresponding colonies complement each other.
You will notice in Figure 33 that most cells are filled with question marks to show that
their complementation status is unknown.  Those cells that record the complementation
of a colony with itself, however, are automatically filled with minuses (-), since colonies
cannot complement themselves.

We know  that colonies C4 and C6 do not complement.  We can record this information
by clicking twice at the intersection of row C4 and column C6 (or vice-versa).  The first
click changes the cell to a plus (+) which would indicate complementation.  The second
click changes the cell to a minus.  The mouse pointer in Figure 33 is pointing at the
intersection of row C4 and column C6.
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Figure 33. An alanine complementation worksheet.

After you have recorded complementation information in the worksheet you may
want to lock it to guard against accidental changes.  To lock a worksheet, click on the
padlock button ( ) in the upper left corner of the window.  Clicking a second time will
release the lock.

As with the phenotype worksheet, you can drag rows and columns of the
complementation worksheet to present the information more conveniently.  This can
be helpful to clarify complementation groups.

Quitting

This is the end of the tour of Complementation Testing.  If you want to quit at this
point, you can do so by choosing the Quit  item from the File menu.  You will be asked
if you want to save your work. If you decide not to quit after all, click on the Cancel
button.  If you save your work, the section in the reference section entitled Opening a
Saved Problem will tell you how to restore the problem to where you left it.

If you want more detail on using  plates and worksheets, read the relevant sections of
the Reference section.

If you want a taste of some of the other things that µGCK can do, read the other Tour
sections.

If you want details on exactly how the computer simulates various aspects of cross
feeding  and inoculation, read the How µGCK Works section.
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A Tour of Conjugation Mapping with µGCK

This tour assumes that you have completed at least one of the other tours and feel
comfortable with the basic mechanics of manipulating plates, tubes and worksheets.  If
you just finished a different tour, you can choose New Problem from the File menu to
start a new problem.  This is equivalent to starting the program over again.

Looking at Colony Phenotypes

Open the phenotype worksheet by choosing the Phenotype Worksheet  from the
Analysis menu.  Notice that all the colony phenotype information has been filled in
and that there is an additional row at the top of the worksheet that you have not seen
before (see figure 34).  This row records the status of the F Plasmid in each colony. Hf is
an abbreviation for Hfr and refers to bacteria with the F Plasmid integrated into their
chromosomes.  These are colonies of donor bacteria.  F- bacteria lack the F Plasmid and
are recipients during conjugation.

Figure 34. A phenotype worksheet with F Plasmid information.  Columns have been rearranged to
cluster Hfr and F colonies.

Selecting Colonies to Conjugate

For this example we will conjugate bacteria from colonies A2 and D2.  A2 is an Hfr
colony of ala+, tyr- bacteria.   D2 is an F- colony of ala-, tyr+ bacteria.    To select two
colonies, click on one of them and then click on the second colony while holding down
the shift key.
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Figure 35.  The field plate with colonies A2 and D2 selected.

Conjugating

Once you have selected two colonies, choose Conjugate  from the Colony menu.  The
window shown in Figure 36 will open for you to enter the conjugation time.

Figure 36.  Choosing the conjugation time.

Click on the OK  button to start conjugating.  When µGCK is finished with the
conjugation (it may take some time), it will create a tube filled with the conjugate
population (see Figure 37).   This tube is created with a complete nutritional medium.
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Figure 37.  A tube full of conjugant bacteria.

Plating the Conjugate Population

The tube that results from the conjugation has a combined population of parental
bacteria and any recombinants from the conjugation.  To see if the conjugation has
produced any recombinants at the alanine locus, we need to plate the tube on a
restrictive medium that will not allow either of the parental strains to grow.

To plate the tube, select it and choose the Plate Tube on New Medium  option from the
Tube menu.

Figure 38.  Setting up a restrictive medium to plate the conjugant population.
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In this case a plating medium that is lacking in both alanine and tyrosine has been set up
so that neither of the parental strains will grow, but any recipient that have picked up
the ala+ from the donor strain will grow.  Figure 39 shows the resulting plate.

Figure 39.  The plated result of the conjugation experiment.

Colonies did grow on plate 2, so we got some recombinants after 50 minutes.  The
alanine locus is within the first 50 minutes.

If you want to look at the phenotypes of the colonies on this new plate, you would
expect to be able to ask for the phenotype worksheet.  If you look at the Analysis
menu, however, you will see that the Phenotype Worksheet  option is gray to indicate
that it is not available.  This is because there are now two plates with different colonies
on them, and µGCK does not know which to use.  In this situation you must select a
plate before asking for the phenotype worksheet.

Quitting

This is the end of the tour of Conjugation.  If you want to quit at this point, you can do
so by choosing the Quit  item from the File menu.  You will be asked if you want to
save your work.  If you decide not to quit after all, click on the Cancel  button.  If you
save your work, the section in the reference section entitled Opening a Saved Problem
will tell you how to restore the problem to where you left it.

If you want more detail on using  plates, tubes, and worksheets, read the relevant
sections of the Reference section.

If you want a taste of some of the other things that µGCK can do, read the other Tour
sections.

If you want details on exactly how the computer simulates various aspects of
conjugation, read the How µGCK Works section.
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Reference

Plates

Figure 40.  The parts of a plate.

Reading a Plate

µGCK plates may be blank, have colonies, or have a bacterial lawn.  Most plates created
while working with µGCK have one or more colonies and look somewhat like Figure
41.  Each of these colonies represents an isogenic strain of bacteria.  Colonies are
identified by row letter and column number.  The pointer in  Figure 41 is on colony G2.

Figure 41.  A plate with 18 colonies.

Blank plates (see Figure 42) result from plating  tubes with  very small populations  or
from plating a tube onto a plate with media that does not allow any bacteria to grow.
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In any case, blank plates have no living bacteria.  Although it is possible to replica plate
a blank plate, only blank plates will result.

Figure 40.  A blank plate has no living bacteria.

Lawn plates (see Figure 43) have such a high population of bacteria that there are no
distinct colonies, only a uniform lawn.  Lawn plates often arise during serial dilution
when tubes with high population densities are plated1.

Figure 43. A lawn plate.

Gridding a Plate

To make it easier to read the names of colonies on a plate, you can superimpose a grid
over the plate by clicking on the grid button in the upper right corner of the plate
window.  The plate in Figure 44 has the grid turned on and the mouse pointer is on the
grid button.

                                                
1It is legal to replica plate a lawn plate, but the results are not realistic.  No matter what the medium
used for the replica, the result will be a lawn plate, even if none of the bacteria in the lawn should be
able to grow on the replica.  This is a bug.
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Figure 44. A plate with a superimposed grid.

Shrinking a Plate

When you have several plates on the screen you may want to shrink some of them to
clear space.  You can do this by clicking in the close box which is the white rectangle in
the upper left-hand corner of the window.  This will cause the plate to shrink to an icon
like that shown in Figure 45.

Figure 45. A plate that has been reduced to an icon.

To re-expand a plate icon, double click somewhere on the icon.  You can select plates in
icon form and replicate them, autoclave them, or ask for their histories.  You cannot,
however, select individual colonies.

Zooming a Plate

You can expand a plate to a large size (see Figure 46) by zooming it.  To zoom a plate,
click in its zoom box (the concentric squares in the upper right).  To return a zoomed
plate to its former size, click on the zoom box again.
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Figure 46.  A Zoomed plate.

Selecting a Plate

Before you can do anything with a plate or a set of plates you need to select it.  To select
a plate, click on it somewhere other than on a colony  or a button.  Clicking on its title
works fine.  A selected plate title will be shown as white on black instead of the
unselected black on white  (see Figure 47).

Figure 47.  A selected plate.  Note that the title "Field Plate" is highlighted.
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Taking Notes on a Plate

Clicking on the notepad button ( , upper left corner of every plate) will open a window
which can be used for taking notes.  You can type into this notepad, paste pictures from
other GCK windows into it, print it, or copy it into a word processor to help you
prepare your lab report.

Getting the History of a Plate

It is easy to forget how you created a particular plate.  You can ask µGCK to jog your
memory by selecting a plate and choosing Plate History from the Plate menu.  µGCK
will open a notepad window with a short description of where the plate came from.  If
you select more than one plate, you will get the histories of all selected plates in one
note.

Autoclaving a Plate

If you no longer have any need for a plate, you can autoclave it.  To autoclave a plate,
select it and choose Autoclave Plate from the Plate menu.  Since autoclaving is not
reversible, you will be asked for confirmation.

Tubes

Figure 48.  A turbid tube.  The blank dilution factor indicates that this tube has not been diluted.

Reading a Tube
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Tubes are either clear or turbid.  The tube pictured in Figure 48 is filled with a gray
pattern to show that it is turbid.  A turbid tube contains enough living bacteria so that
the liquid is not clear.  A clear tube may contain living bacteria but not enough to affect
the transparency of the liquid medium.  Figure 49 shows a clear tube.

Figure 49.  A selected clear tube.  The dilution factor is one tenth.

Shrinking a Tube

When you have several tubes on the screen you may want to shrink some of them to
clear space.  You can do this by clicking in the close box which is the white rectangle in
the upper left-hand corner of the window.  This will cause the tube to shrink down to
an icon like that shown in Figure 50.

Figure 50. A tube that has been reduced to an icon.

To re-expand a tube that has been shrunk, double click somewhere on the icon.  You
can select tubes in icon form and dilute them, plate them, autoclave them, or ask for
their histories.
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Selecting a Tube

Before you can do anything with a tube or set of tubes you need to select it.  To select a
tube, click on it somewhere.  Clicking on its title works fine.  A selected tube title will be
shown as white on black instead of the unselected black on white (see Figure 49).

Taking Notes on a Tube

Clicking on the notepad button ( , upper left corner of every tube) will open a window
which can be used for taking notes.  You can type into this notepad, paste pictures from
other GCK windows into it, print it, or copy it into a word processor to help you
prepare your lab report.

µGCK automatically inserts the dilution factor used to create the plate when a tube is
plated with automatic dilution.

Getting the History of a Tube

It is easy to forget how you created a particular tube.  You can ask µGCK to jog your
memory by selecting a tube and choosing Tube History  from the Tube menu.  µGCK
will open a notepad window with a short description of where the tube came from.  If
you select more than one tube, you will get the histories of all selected tubes in one
note.

Autoclaving a Tube

If you no longer have any need for a tube, you can autoclave it.  To autoclave a tube ,
select it and choose Autoclave Tube  from the Tube menu.  Since autoclaving is not
reversible, you will be asked for confirmation.

Constructing Media

Several operations in µGCK require you to construct a medium.  You construct media
with the help of the media matrix shown in Figure 51.
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Figure 51.  Choosing the medium for a new plate.

The media matrix has a column for every existing plate and tube and a column for the
new plate or tube that you are about to the create.  The new column is to the left of all
the other media columns and immediately to the right of the list of nutrients and
antibiotics.  In Figure 51 the new column is labeled "Plate 2" because the new media will
be used to create plate 2.

To create the new medium, fill in the blank column with the nutrients or antibiotics you
want by any of the methods described below:

Click on a Cell: To include an ingredient in the new medium, click on the blank cell
next to the ingredient name.  An ingredient is included when its cell is filled with gray.
To remove an ingredient, click on the filled cell and it will go blank.  After you have
clicked on a cell you can drag up or down to change other cells in the same way.

All Nutrients: Click on this button to include all nutritional ingredients in the new
medium.

Invert Nutrients: Click on this button to reverse the status of all nutritional ingredients.

Clear Nutrients: Click on this button to remove all nutritional ingredients from the
new medium.

Clear Antibiotics: Click on this button to remove all antibiotics from the new medium.

Copy Medium: To copy the medium used for another plate or tube, click on any of the
cells for that medium.  The medium will be copied over into the first column.
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Drag Rows:  You can rearrange the standard order of ingredients by dragging the
ingredient names up or down.  This will change the standard order used everywhere
else as well.

Drag Columns:  You can rearrange medium columns by dragging their names around.
You cannot drag the first column or drag any other column into the first position.

Experiments with Plates

Replica Plating a Plate

To create a replica plate, select the plate you want to replicate and choose Replicate
from the Plate menu.  You will then need to construct a medium for the new plate as
described in the section Constructing Media.

Experiments With Tubes

Diluting a Tube

To dilute a tube, select it, and then choose Dilute 10 Fold  from the Tube menu.  This
instructs µGCK to take one milliliter of liquid from the selected tube and place it in a
new tube along with 9 milliliters of distilled water.  You may repeat this process as
many times as you think necessary to create a rack of serial dilutions.

After diluting a tube, µGCK will automatically select the new tube for you to make it
easy to plate it or dilute it again.

Automatic Tube Dilution

Many µGCK problems are set up so that tubes are automatically diluted when they are
plated.  In these problems the Dilute 10 Fold  option will probably not exist.  In some
problems there may be a Dilute Automatically  option on the Tube menu which allows
you to turn automatic dilution on or off.  If there is a check mark (√) next to the Dilute
Automatically  option it is turned on.

Plating a Tube

There are three ways to plate a tube depending on what medium you want to use for
the new plate.  To use any of them, select the tube, and then choose the appropriate
option from the Tube menu.

Plating a tube behaves differently depending on whether µGCK has been configured to
automatically dilute tubes before plating.  If not, the resulting plate may be a lawn or
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blank, depending on the number of bacteria present in the tube.  For descriptions of
what this means see the section entitled Reading a Plate.  If automatic dilution is turned
on, the tube's concentration will automatically be lowered so that the plate has distinct
colonies (if possible).  The required dilution will be recorded in the tube's notepad.

Plate Tube on Tube Medium:   This will create a new plate using a copy of the
nutritional medium used in the tube.

Plate Tube on New Medium:  This will ask you to construct the medium to be used for
the new plate.

Plate Tube on Last Medium:  This will create a new plate using the same medium that
was used to create the last plate.

Experiments with Colonies

Inoculating a Tube

You can inoculate a tube with one or more colonies by selecting the colonies and
choosing one of the three Inoculate Tube  options from the Colony menu.  To select a
colony, click on it; to select more than one colony hold down the shift key while
clicking.  The colonies you select may be on one or several plates.

When you inoculate a tube with a set of colonies, µGCK will put equal quantities of each
strain of bacteria into a new tube and incubate the tube.  If all strains are equally able to
grow in the tube medium they will be present in equal proportions.  If one or more
strains cannot grow, it will not be noticeably present in the final population of the tube.

In µGCK all intermediates in a biochemical pathway (cistron products) can diffuse
through cell walls.  If two auxotrophic strains are grown together in a liquid medium,
they will complement if their defects are on different cistrons.  If the defects are on the
same cistron, complementation will not occur.

Inoculating a tube with a population containing both Hfr and F- strains will not result in
any conjugation.  To conjugate two strains you must explicitly request conjugation.

Inoculate Tube in Plate Medium:  This will  create a new tube that contains the same
nutritional medium as that used  in the plate that contains the first selected colony.

Inoculate Tube in New Medium: This will ask you to construct the medium to be used
for the new tube.

Inoculate Tube in Last Medium:  This will create a new tube using the same medium
used to create the last tube.



Microbial Genetics Construction Kit User Manual   45                                                            

Conjugating Two Strains

To conjugate two strains of bacteria, select the two colonies  and choose Conjugate
from the Colony menu.  You will be asked to specify how much time the two strains
should be allowed to conjugate and a new tube will be created that contains the
conjugant population.

For details on the model of conjugation used, consult the section on conjugation in the
How µGCK Works section.

Unfortunately, tubes created by conjugation tend to take up large quantities of
computer memory .  It is a good idea to autoclave tubes used for conjugation as soon as
you are finished with them.  If you think you might need a tube later, you can save a
copy of your problem on disk (using Save As), and then delete the tube.  You can open
this saved problem later and resume work with the deleted tube.

Analyzing and Organizing Your Data

Media Matrix

The media matrix, available on the Analysis menu, displays the media used by all
current plates and tubes.  It is useful when you need to look up the media used in a
previous experiment or to compare two media.

Figure 52. The media matrix.

The rows of the media matrix record the presence or absence of the nutritional factors
and antibiotics named.  The columns name the plates and tubes referred to.  In the
media matrix shown in Figure 52, plate 3 is shown to have the nutritional factors
alanine, tyrosine, and biotin.
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You may reorganize the media matrix to bring items of interest together by dragging
rows and columns.  To drag a row or column, place the mouse pointer on the name of
the row or column and drag the dotted outline to the desired position.

Phenotype Worksheets

Phenotype worksheets record the phenotypes of colonies.  Depending on the way that
µGCK is set up, they either provide a place for you to record your observations about
colony phenotypes or display the phenotypes automatically.

Opening a Phenotype Worksheet

To open a phenotype worksheet, choose the Phenotype Worksheet  from the Analysis
menu.  If there is only one possible phenotype worksheet because there is only one
plate, or because all plates are derived from one plate by replica plating, the  menu item
will always be active.  If there are two or more possible different phenotype
worksheets, you need to select the plate before choosing the menu item.

Reading a Phenotype Worksheet

Phenotype worksheets record the phenotypes of the colonies listed along the top with
respect to the categories listed along the left.  The title of the phenotype worksheet
indicates which plate the colonies come from (in Figure 53 the P1 refers to Plate 1).

The first line shown in Figure 53 may be displayed if the status of the F plasmid is
significant for a problem.  If it is displayed, Hf  indicates that the colony is an Hfr strain
(has the F plasmid integrated into its chromosome), F- indicates that the strain does not
contain the F plasmid, and ? indicates that its status is unknown.

Nutrient synthesis ability is indicated by a +  if the strain is prototrophic (can synthesize
the nutrient), a - if it is auxotrophic (cannot synthesize the nutrient), or a ? if its status is
unknown.

Antibiotic resistance is indicated by an r if the strain is resistant to the antibiotic, an s if it
is sensitive to the antibiotic, or a ? if its status is unknown.
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Figure 53.  A filled in and locked phenotype worksheet with a plasmid row.

Controlling a Phenotype Worksheet

To change the content of a cell click in the cell; it will change to the next possible value.
To change several cells to the same value, click and drag across the cells you want to
change.

A worksheet may be locked to prevent accidental changes to its contents.  A locked
worksheet is indicated by the closed padlock symbol ( ) in the upper left corner of the
window.  An unlocked worksheet is indicated by an open padlock symbol ( ).  To lock
an unlocked worksheet or unlock a locked one, click on the padlock symbol.

Shrinking a Phenotype Worksheet

You may shrink a phenotype worksheet to icon form by clicking in the close box (see
Figure 54).  To re-expand the icon, either double click on it, or reselect Phenotype
Worksheet  from the Analysis menu.

Figure 54. A phenotype worksheet in icon form.

Filling a Phenotype Worksheet

Some µGCK problems allow you to fill a phenotype worksheet automatically.  If there
is a Fill Phenotype Worksheet  item on the Analysis menu, you can do this.  Select the
phenotype worksheet by clicking on its title and then choose the menu item.
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Destroying a Phenotype Worksheet

To destroy a phenotype worksheet, select it by clicking on its title and then choose
Destroy Worksheet(s)  from the Analysis menu.

Complementation Worksheets

Complementation worksheets record the complementation behavior of a plate's
colonies.  Depending on the way µGCK is set up, they either provide a place for you to
record your observations, or they are automatically filled out. The title of the
complementation worksheet indicates which plate the colonies come from and which
marker is shown.  In Figure 55 the title tells us that this complementation worksheet
records the complementation status of the colonies on plate 1 (P1) for the penicillin
marker.

Opening a Complementation Worksheet

To open a complementation worksheet, choose Complementation Worksheet from the
Analysis menu.  If there is only one plate, or if all plates are derived from one plate by
replica plating, the  menu item will always be active.  If there are two or more possible
plates with different colonies, you will need to select a plate before choosing the menu
item.

Reading a Complementation Worksheet

Complementation worksheets record whether or not two strains will complement each
other.  All the colonies in the plate are listed along the top and along the left side.  If
there is a - at the intersection of two strains it indicates that those strains do not
complement2.  A + indicates that they do complement, and a ? indicates that their status
is not known.

                                                
2Note that the minuses here record complementation, not the possibility of growth.  If B5 is
prototrophic for a nutrient, it will certainly grow in the absence of that nutrient, so if the worksheet
recorded growth we might expect to have a + at the B5, B5 intersection.
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Figure 55. An unfilled out, unlocked complementation worksheet for penicillin.

Controlling a Complementation Worksheet

To change the content of a cell click in the cell; it will change to the next possible value.
To change several cells to the same value, click and drag across the cells you want to
change.

A worksheet may be locked to prevent accidental changes.  A locked worksheet is
indicated by the closed padlock symbol ( ) in the upper left corner of the window.  An
unlocked worksheet is indicated by an open padlock symbol ( ).  To lock an unlocked
worksheet or unlock a locked one, click on the padlock symbol.

Shrinking a Complementation Worksheet

You may shrink a complementation worksheet to icon form by clicking in the close box
(see Figure 56).  To re-expand the icon, either double click on it, or reselect
Complementation Worksheet  from the Analysis menu.

Figure 56. A phenotype worksheet in icon form.

Filling a Complementation Worksheet
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Some µGCK problems allow you to fill a complementation worksheet automatically.  If
there is a Fill Complementation Worksheet  item on the Analysis menu you can do this.
Select the complementation worksheet by clicking on its title and then choose the menu
item.

Destroying a Complementation Worksheet

To destroy a complementation worksheet, select it by clicking on its title and then
choose Destroy Worksheet(s)  from the Analysis menu.

Taking Notes

Using Notepads

Every plate and tube has an associated notepad;  to open it, click on the notepad icon
( ) in the upper right corner.   The notepad stays in existence as long as you do not
autoclave its associated plate or tube.  You can close it temporarily by clicking in its
close box, and when you re-open it, any notes you typed will still be there.

Use the notepad just as you would any other Macintosh word processor.  You can type
into it, paste pictures into it, select parts of it to cut or copy into the clipboard, and print
it.

If you are not familiar with standard Macintosh word processing methods you should
consult your Macintosh Owner's Guide for a description.
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Printing Notepads

To print a notepad, make sure that it is the frontmost window (clicking somewhere in
the window will make it frontmost).  The frontmost window is the only window which
has a set of parallel horizontal lines around its title.  Then choose Print Notepad from the
Edit menu.

For more information on notepad use, see the section on Communicating With Other
Programs.

Cleaning Up the Benchtop

After you have been working for a while your lab bench (the computer screen) is likely
to get quite messy.  The Clean Up  option on the Utilities menu will straighten things
up by putting things in their original places and closing certain windows.

Changing the Cleanup Process

The standard Clean Up process places plates, tubes, worksheets, and other windows on
your screen in a way appropriate for the standard Macintosh 9-inch screen.  If you have
a larger screen or if you do not like the way clean up works, you can change it.  To do
this, choose the Clean Up Options  option on the Utilities menu.  The window shown
in Figure 57 will open.

The check boxes at the bottom of the window allow you to specify which windows
should be automatically closed or collapsed to icon form during a clean up operation.

The box in the upper part of the window shows where each of the different kinds of
windows created by µGCK will be placed when it is first created and when you ask for
a clean up.  In Figure 57, the three black plate outlines represent the placement of the
first three plates (later plates will be placed on top of the first three, offset a little).  You
can change the number of rows and columns of plates, and the spacing between them,
by adjusting the large rectangle with the little grow box in the lower right corner.  You
can change the placement of the group of all plates by dragging the big rectangle
around the screen.

To change the placement of other kinds of windows, click on the Next  button to bring
the next set of windows to the top, or click directly on the gray boxes representing the
window you want to change.
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Figure 57.  The Clean Up Options window.

Communicating With Other Programs

All communication between µGCK and other programs takes place via the Macintosh
Clipboard.  Think of the clipboard as a place you can temporarily store a piece of text or
a picture from one program, and then retrieve it from another program.  You proceed
by Copying material from one program into the clipboard, switching to the other
program, and then Pasting  the clipboard into the second program.

This can be quite clumsy if you need to move several different things between the same
two programs, since the clipboard can only hold one thing at a time.  In this situation
you may want to look into using the Macintosh Scrapbook (see your Macintosh Owner's
Guide) which can hold more than one thing at a time.

Cut, Copy, Paste, and Clear

You can use Cut, Copy, and Paste  to move text and pictures between µGCK notepads
and other programs.  Unfortunately, however, it is not possible to copy and paste
mixed text and pictures at one time.

 To copy a notepad that contains both text and pictures you need to do the following:
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• Select the entire content of the notepad.  You can do this by clicking
before the first word and dragging to the end, or by clicking once before
the first word, scrolling to the end, and shift-clicking after the last
character.

• Choose Copy  from the Edit menu.

• Paste the result into an external word processor.  Where pictures exist in
the original notepad you will see a little box (�).

• For each picture in the notepad:
• Select the picture.  It is critical that you select only the picture and

no surrounding blank space.
• Choose Copy  to put a copy of the picture on the clipboard.
• Paste the picture into your word processor.

Copy Window

The Copy Window  option on the Edit menu is always active as long as there is at least
one window open.  It will put a picture of the current frontmost window on the
clipboard.  Once it is on the clipboard it can be pasted into a notepad or into another
Macintosh program.

The picture of the window looks exactly like the window.  This is potentially confusing
because it is not a window any more, but just a picture of one.  This means that the
close box and other controls will not work.

Copy Window Data

The Copy Window Data  option on the Edit menu will put a copy of the data  a window
contains on the clipboard in a form that is usable (not only displayable) by other
programs.  The data is in tab delimited text  format that is usable by many word
processors, spreadsheets, data base managers, and graphing programs.

Tab delimited text is text arranged in columns with each column separated by a tab.  If
you paste this into a word processor you will need to set the tab stops to line up the
columns.

The media matrix, phenotype worksheets,  and complementation worksheets are the
µGCK windows that export their data in this way.  The data stored in the frontmost
window will be exported.

Printing a Window

You can always print the frontmost window, if you have a printer attached to your
computer, by holding down three keys simultaneously.  The three keys are the shift
key, the command key( �), and the "4" key.   If you also press the caps lock key, the
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entire computer screen will be printed.  These procedures are not only part of µGCK
but are characteristic of every Macintosh program.

Getting Help

There are several ways to ask for help from µGCK or any other BioQUEST program.

Why Can't I Use This Menu Item?

At any one time several menu items will be gray, indicating that they are inactive and
therefore cannot be used.  Active menu items appear in black.  It is not always obvious
why a menu item is inactive, or how to make it active.  In µGCK, if you try to choose an
inactive menu item, you will get a short message explaining what to do in order to
enable it (see Figure 56).  Usually this means selecting an object.

Figure 58. A Help message explaining  why the Replicate Plate item is inactive.

Use the scroll bar on the right to see text that is not immediately visible.  When you
have finished reading the help message, you can dismiss it by clicking on the Cancel
button.

What Is This Thing For?

To find out something is or does, you need to be in help mode.    To enter help mode,
press the command key ( �) while simultaneously pressing the question mark (?) key.
On some keyboards there is a key labeled help.  If your keyboard has a help key, it will
do the same thing.

When you are in help mode, the mouse cursor will look like this , instead of the usual
arrow shape.  In help mode, all menu items are always active.  Selecting a menu item
will give you a short description of what the menu item does (see Figure 59).
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Figure 59. An Explanation of the Replicate Plate menu item

Besides menus,  you can click on just about anything and get some information about it.

Usually, you automatically drop out of help mode after you get help once.  Sometimes
you want to ask for help on several things and it is useful to stay in help mode.  If you
hold down the option key while clicking, you will stay in help mode.
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What About the Big Picture?

The general help system is accessible from the Help With µGCK  option under the
Apple ( ) menu.  If you choose this option you will be given a list of topics from which
to choose the subject of interest (see figure 60).  To open a topic, click on it and click the
Open  button at the bottom of the help window, or double click on the topic line.
When you open a topic you will either see a list of sub-topics or a discussion of the
subject.

At the bottom of a help window there will always be a Cancel button.  Pressing it will
close the help window.  There will often be a Back  button as well.  Pressing it will
return you to the topic list that led you to the current window.  Sometimes there will be
other buttons that should be labeled so as to be self explanatory.

Figure 60.  The Help with µGCK  topic list.  Clicking Open will lead to information about saving and
restoring problems.

Saving and Opening a Problem

Saving a Problem

You can save the state of the problem you are working on at any point by choosing the
Save  option from the File menu.  This saves everything so that you can later come
back to the problem in the same state it was in when you left it.

There are a number of reasons you may want to save a problem.  The simplest is that
you may want to take a break and come back to a problem later.  Another reason is to
keep all of your original research data.  If someone then challenges your conclusions,
you can go back to the original organisms with new questions.  Or you may want to
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save a copy of a problem before you do any work at all so that another research team
can work on exactly the same problem and you can pool, and argue over, your results.

You may also want to save against the possibility of catastrophe in the form of as
power failure or an problem with the program that causes it to stop working suddenly.

When you choose Save  the first time, you will be asked to give the problem a name
(see Figure 61).  If the process of giving a file a name is unfamiliar to you, please refer to
BioQUEST: Macintosh Basics.

Figure 61. A Save Problem dialog box.  By default, the problem will be saved under the name
'Untitled0'.

When you are ready, click the Save  button to save the problem, or click the Cancel
button if you decide not to save.

The second time you choose Save, your problem will automatically be re-saved under
the same name you used the first time.

If you want two different copies, use the Save As  option instead of Save.  This will ask
you for another name.

Opening a Saved Problem

There are two ways to open a previously saved problem.  The simplest way is to
double click on the saved problem's icon from the Finder (see Figure 62).
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Figure 62. A saved problem icon.

Alternatively, if you are already running µGCK, you can choose Open  from the File
menu and choose your problem from the list presented there.

Note that you can only have one problem open at a time.  If you try to open a second
problem, you will first be asked if you want to save the current problem.

Designing Your Own Problems

In order to create or edit µGCK problems you must have access to a copy of µGCK
with the Edit Problem Types  option under the Utilities menu.  Most copies of µGCK
have this capability disabled so as to prevent users from  looking at the description of
the problem they are trying to solve.

If you choose Edit Problem Types, you will first be presented with a list of the available
problems and given an opportunity to delete a problem, to create a new problem or to
open and edit a currently existing problem (see Figure 63).

Figure 63. Choosing a problem type to change, or delete, or creating a new problem type.

Once you have selected a problem to work on, you will be given an opportunity to
change the problem type's name, to change the field population parameters, to change
the genome configuration, or to modify the problem menus (see Figure 64).



Microbial Genetics Construction Kit User Manual   59                                                            

Figure 64. Change problem type name and select parameters to change.

You can edit the problem type name with the normal Macintosh text editing techniques.
To edit one of the parameter sets, click on the appropriate button.

Field Population Parameters

Figure 65. Field Population Parameter editing.
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The radio buttons on the first line govern whether the initial field population will be
shown in a test tube or a plate.  If they are shown in a plate, the strains will be roughly
equally represented.  If they are shown in a tube the relative proportions will be
randomly assigned so as to make serial dilution on to a restrictive medium more
interesting.

The second line allows you to set the number of genetically distinct strains you want to
be represented in the field population.  The number used will be between the minimum
and maximum set here.

The third line governs how complex the genetic makeup of a particular strain will be by
setting the number of markers allowed per cell.  A marker in this case is auxotrophy for
nutrients or resistance for antibiotics.

The final parameter is the distribution of the F plasmid in the field population.  To set
the distribution, drag the black rectangle to show the distribution you want.  In Figure
65 it is set so that the entire population is F free.

Click the Check  button to check that the parameters you have asked for here are
compatible with parameters set elsewhere.  This check is not infallible.
Click Cancel  to discard the changes you have made to this problem,  or OK  to keep
them.

Genome Configuration

Figure 66.  Genome Configuration editing.
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Length:  The first line allows you to set the length of the bacterial chromosome in
minutes.  Make it smaller for a chromosome more densely populated with markers.
This is also significant for conjugation.  Longer chromosomes will lengthen the time
required for conjugation.

Markers:  The second line sets the size of the universe of possible markers from which
subsets will be drawn and assigned to particular strains.  In Figure 66 we have decreed
that there be seven possible markers.

Cistrons:  The number of cistrons per marker is significant for complementation
experiments and conjugation experiments that are trying to determine the number of
cistrons or looking for recombination between them.

Beads:  A bead is the smallest unit of a bacterial chromosome that µGCK models
(roughly equivalent to 100 codons).

Distribution:  This roughly controls how many markers will be auxotrophic markers
and how many resistant.  Degradative markers are not yet implemented, they should
be left at 0.

Conjugation Model:  The Time of Entry conjugation model is the simplest and fastest.
It simply finds the probability of entry for a marker and assumes that any marker that
enters a recipient cell will be incorporated into its genome.  The Recombination model
calculates recombination probabilities and allocates the resulting population size
accordingly.  It is a good deal slower than the Time of Entry model.

Checking the Parameters

Once you have set  up the problem type you want, click on the Check  button so that
µGCK can check to make sure that it can create the problem that you asked for.  If
something you asked for is impossible, it will be changed to something possible when
you click on the Check  button.    Check  does not check some things that it ought to
check.  For example, if you ask for more markers than you have nutrients and
antibiotics available, Check will not notice the problem.
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Menu Parameters

Figure 67. Menu Editing.

Menu Subset:  The menu subset options allow you to control what menus and menu
options appear in a problem.  The first two are standard menu subsets appropriate for
the two applications.  The third option turns on every possible menu and every possible
menu item.  The fourth option opens up another window (see Figure 68) that allows
you to individually turn particular menus or menu items on and off.

Tube Dilution:  If this item is checked plated tubes will be automatically diluted.

Fill Out Nutrient Information:  If this is checked the nutrient and antibiotic areas of a
phenotype worksheet will be filled out correctly when the worksheet is first opened.

Include Plasmid Information:  If this is checked a line describing the status of the F
plasmid will appear in every phenotype worksheet.

Fill Out Plasmid Information:  If this is checked the F plasmid status will be correctly
filled out when a phenotype worksheet is first opened.

Fill Out Complementation Information:  If this is checked, complementation
worksheets will be correctly filled out when first opened.
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Figure 68. Custom menu editing dialog.

The menu parameter editing dialog (see Figure 68) allows you to decide what menu
options you feel should be available for your problems.  To toggle an entire menu on
and off, click on the check box with the menu name.  To toggle a menu option on and
off, click on the corresponding check box.  A menu or menu option without a check
mark will not be visible when the problem is used.
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How µGCK Works

When µGCK starts a new problem it first has to read the problem parameters and use
them to build a set of genetic rules that we will call the Species Model.  Once it has a
species model, it uses the model to create a field population of organisms and consults
the model when deciding how the species should behave.

This description attempts to be an accurate overview of the internal model of genetics
used by µGCK.  It is simplified so that the details don't obscure the overview and will
certainly change as new genetic phenomena are added to µGCK.

The Species Model

µGCK models a bacterial chromosome as a string of beads, where each bead
corresponds to some constant number of codons.  The correspondence of codons to
beads is set by the model's requirement (for implementation reasons), that a cistron
consist of from 1 to 16 beads.  If we accept the common rough approximation that a
cistron has about a 1000 base pairs or 350 codons, and assume that this corresponds to
3.5 beads, then a bead can be thought of as roughly 100 codons.  This means that the
total range of cistron sizes available is from 100 to 1600 codons.

Bacterial chromosomes are often measured in minutes, where a minute is the length of
chromosome transferred between two conjugating bacteria (at 37˚C) in one minute.
Conjugation in E. Coli occurs at about 1000 base pairs per second which means that we
have about 200 beads per bacterial minute.

Cistrons are parts of groups which together form and regulate a biochemical pathway
with (in this model anyway) phenotypically observable results.  For the purposes of this
model, these groups of cistrons are referred to as markers.  A marker may consist of
from one to n cistrons where n is some maximum that must be set when µGCK is
compiled (at the moment n= 5).  For now, the cistrons comprising two different
markers must be disjoint.  We would like to remove this constraint sometime.

Markers in µGCK may be of three types: Resistance, Auxotrophic, or Degradative.
Resistance markers control sensitivity and resistance to antibiotics (or possibly to other
chemical or phage attack).  Auxotrophic markers control a bacterium's ability to
synthesize needed nutrients from the basic materials available in a minimal medium.
Degradative markers (not completely implemented yet) control the ability to degrade
complex sugars into basic glucose.

The relationship between a marker and its component cistrons is extremely simple at
the moment.  Each cistron is assumed to code for a product which takes part in a serial
biochemical pathway.  If any part of the pathway is blocked by a defective  cistron, the
marker is defective.  Each cistron product may be marked as non-diffusible, which
means that it cannot complement at all, diffusible, so that it can complement another
defective cistron within the same cell (in a merozygote), or cell wall diffusible so that
two different cells can complement in a cross feeding experiment.  In the current µGCK
all cistron products are cell wall diffusible.



Microbial Genetics Construction Kit User Manual   65                                                            

Conjugation

The model of conjugation employed by µGCK is restricted to those forms of
conjugation mediated by the F plasmid in the Hfr configuration.  At the moment there
is only one insertion point for the F plasmid.

Once the user chooses to conjugate two populations of bacteria, one of which is Hfr and
one of which is F-, the model must model the actual act of conjugation.  The outcome of
a conjugation cross is always described in terms of the number of resultant
recombinants observable by conventional selective techniques.  This is used to generate
initial gross maps of a genome via time of entry mapping and may also be used to
some extent for more fine structure mapping by looking at recombination frequencies.

An isogenic Hfr strain has one particular F insertion point so it always transfers the
bacterial chromosome starting at a particular origin and in the same direction.  If we
look at just one mating pair, the chromosome is transferred from the Hfr donor to the
F- recipient at a roughly constant rate (after a variable set up time) until the connection
is broken either by deliberate shaking by the experimenter or at random with a
constant probability per unit time.  Once a segment of donor chromosome has entered
the recipient cell it may recombine with  the local chromosome.  The actual
recombination process is not well understood.  Parts of the donor chromosome that do
not recombine, may persist for a while (possibly even long enough to recombine with
the recipient's descendants) but eventually degrade.

Usually, of course, one is not dealing with a single conjugating pair but with a very
large population of bacteria which meet and begin to conjugate over some time
interval.

In this model we have made a number of simplifying assumptions.  First, once the
donor chromosome has done whatever recombining it is going to do with the initial
recipient, it disappears.  Also, we assume that all pairs begin to conjugate at the same
time, and that chromosome transfer always occurs at the same rate (roughly that of E.
Coli at 37°C on optimal media).  Then, since recombination mapping using conjugation
is not that common, we have made the drastic assumption that the probability of a
crossover between any two beads is constant, independent of other nearby crossovers.
This means that we cannot model interference, but results in a considerable
simplification in the computational complexity of the problem.
We calculate the proportions of various recombinants in the final population by
calculating, for every cistron that differs between the parental types, the probability
that it will enter a recipient cell in the time available, and the probability that it will
recombine with the recipient chromosome.  Since we have postulated that all
recombination events are independent, we then find the probability of multiple
recombinants by multiplying the probabilities for individual cistrons.

In more detail, the probability that a particular donor cistron will recombine with the
recipient genome is the probability that it will enter the recipient (e) times the
probability that it will recombine.  The probability of recombination is influenced
strongly by the length of donor chromosome on both sides of the cistron so this
calculation has to be re-done for each possible length of entering chromosome.
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Definitions

limit = Maximum length of chromosome that could possibly enter the recipient.
This is a function of the time before agitation and the rate of chromosome
transfer.
start = length of chromosome between the transfer origin and the beginning of
the entering cistron.
b = probability of breakage between two entering chromosome beads.
c = probability of a crossover between two chromosome beads.
e(l) = probability that a particular length l  of donor chromosome will enter the
recipient.
e (l) = b (1-b)l  (roughly)
O(l) = probability of an odd number of crossovers in a chromosome segment of
length l beads.

O(l) =
l
x





c

x
1 − c( )

l −x
for odd x

x =1

l

∑
r  = probability that a cistron, once in the recipient, will yield a recombinant.

r = e x( )O s t a r t( )O x − s t a r t( )
x= start

limit

∑

The Model

The probability that a cistron will enter a donor and produce a recombinant is
e(start)r.

Hayes[2] mentions .06 as a reasonable value for b.  Curtiss[3] states that the
correct value is .064.  We use .06/200 = .0003 per bead.

We find a reasonable value for c  from measures of linkage distances correlated
with time-of-entry differences.  Hayes suggests that two markers separated by 5
minutes will exhibit a recombination probability of 50%.  Curtiss suggests a
recombination rate of 20% per minute.  We derived a value of about .05 per bead for  c .

We make a number of simplifications to lower the computational load to
manageable proportions.  First, we use a Poisson approximation to the binomial
described above.  Second, we evaluate entry and recombination probabilities not at
every bead but at every nth bead.

The needs of students and teachers using the µGCK conjugation model will vary.
We anticipate that most of the use of conjugation will be for time-of-entry mapping.
Since this does not require any analysis of recombination and since the calculation of
recombination frequencies is quite time consuming, we have provided  one model of
conjugation which does no calculation of recombination at all.  It simply finds the
probability of entry for markers and assumes that any marker that enters a recipient
cell will be incorporated into its genome.  Another model does calculate recombination
probabilities but with a relatively large step size so that its accuracy over short distance
is not to be trusted too far.
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Glossary

Active Menu An active menu appears as black on white.  This is a sign that at
least one of the items on the menu is active.  An active menu item
is one that you are currently allowed to choose.  Inactive menu
items, which appear in gray, are not allowed at the moment.  To
find out why an inactive menu item is inactive, try to choose it.
You will get a short explanation of how to activate it.

Active Window The active window, also called the frontmost window, is the
window with the horizontal lines around the title.  There should
only be one active window.  See also: Selected Window.

Auxotroph A microorganism that requires a nutritional supplement for
growth usually because of a defect in a synthetic pathway.

Bead In µGCK ,the minimal unit of chromosomal simulation.  At the
moment a bead is about 100 codons long.

Check Box A standard way to turn something on or off.  An 'X' in the box
means it is turned on, no 'X' means it is turned off.  Click in the
box to toggle between the two states. ex.  

Cistron A section of a chromosome that codes for a particular
polypeptide.  In µGCK this polypeptide is always a single step in a
biosynthetic pathway.

Conjugate Sexual reproduction in bacteria.  µGCK conjugation is modeled on
that of E. Coli (F plasmid mediated).  One bacterium, the donor
(hfr), transfers all or part of its genetic material some of which
may be incorporated into the recipient (F-) bacterium.

Colony A contiguous group of isogenic bacteria derived from a single
ancestor and growing on a petri plate.

Complement If two mutants complement each other they are able, in
conjunction, to express the wild phenotype.

Clipboard The clipboard is an invisible place where something (usually a
picture or a few words) can be stored for a moment.  When you
Copy  text you put it on the clipboard.  When you Paste  you are
pulling something off the clipboard to insert into a document.
The clipboard is part of the computer, not part of the particular
program you are using, so you can use it to transfer information
from one program to another.

Cross Feed Complementation that occurs between bacteria via the diffusion
of pathway intermediate products between the cells.
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Customize The ability to change parts of the program to better fit your needs
and instructional objectives.  In GCK you can change the set of
operations available on the menu bar, the range of genetic
phenomena that occur in a problem, and the names of the traits
and variations used by the program.

Dialog Box A window that contains requests for instructions or information.
For instructions on using dialog boxes see your Macintosh
Owner's Guide.

Field Population The population of the first vial to appear on the screen.  This
population was collected from the field and is not the result of a
cross, so its phenotypic ratios are not significant.

µGCK Microbial Genetics Construction Kit (this program).

Isogenic A group of bacteria with the same genotype.

Lawn A plate without distinguishable colonies because of overlap.

Menu At the very top of your Macintosh computer screen  there is a
white bar with a number of symbols and words.  This is called the
menu bar, and each of the symbols and words is the title of a
menu.  For more information about menus and how to use them,
see your Macintosh Owner's Guide.

Mouse Please see your Macintosh Owner's Guide for information about
what a mouse is and how you use it.

Notepad A notepad is a window that you can type into, or insert pictures
into.  It is a place to write notes to yourself, or to collect your
thoughts for a lab report.  Each plate and tube has a associated
notepad.  To open it, click on the  symbol in the upper left of the
vial.

Object When we use the word object in this manual, we mean something
that can be selected.  Colonies, plates, tubes, and worksheets are
the objects in µGCK.

Phenotype The observable properties of an organism.  A result of the
collective action of its genotype and its environment.

Prototroph Opposite of an auxotroph.  A microorganism that does not
require a particular nutrient for growth.



Microbial Genetics Construction Kit User Manual   69                                                            

Scrapbook The scrapbook is a desk accessory that will store more than one
thing for you.  This is an advantage over the clipboard which can
only store one thing at a time.  See  your Macintosh Owner's
Guide for more information on desk accessories and the
scrapbook.

Turbid A tube containing so many bacteria that it visibly  scatters light.
The opposite of a clear tube, which does not have enough bacteria
for the liquid medium to be unclear.

Window A window is an area of the computer screen, usually rectangular,
that displays information.  Most windows have a title displayed at
the top.  For more information see your Macintosh Owner's
Guide.  Plates, Notepads, Phenotype Worksheets, etc. are all
examples of windows.
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Appendices:

It Doesn't Work!

The program won't run.

Have you booted your system properly?
If this question doesn't mean anything to you please look at BioQUEST:Macintosh
Fundamentals or ask someone who has used a Macintosh computer before.

Are you using System 6.0 or later?
µGCK requires system software 6.0 or later to run properly.  To check which version of
the system software you are using, choose About the Finder option under the   menu.

Are you using a Macintosh Plus or later computer?
µGCK will not run on a Macintosh 128 or Macintosh 512.

Maybe it's a bug?
If you answered yes to all of the preceding questions, maybe you have discovered a
problem in µGCK.  Please report the problem and circumstances back to the program
authors.

The program doesn't look like the picture in the manual.

Maybe it is not supposed to look like the picture in the manual.
µGCK can be modified to look quite different from what we have shown in the manual.
Read the section at the beginning of this document A Word of Warning to see if the
difference might be something like this.  Also, ask the person you got the program
from if they have changed something.  If so, they ought to be able to tell you what
differences to expect.

Maybe you have the wrong manual.
µGCK is not in its final form so it changes periodically.  While we try to keep the
manual up to date it does tend to lag a little behind the program.  It is also possible for
the wrong version of the manual to accidentally be included with a program.  The
current version of the program when the manual was last updated is printed at the
bottom of every page.  You can find the current version of the program by running
µGCK and choosing the About µGCK option from the   menu.  If the two version
numbers do not match then this might be your problem.  You should also be able to
find a document called µGCK Version History. This might be able to tell you
something about the differences between your copy of the program and your copy of
the manual.  Otherwise, contact the person you got the program from and ask what
has changed.
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Maybe it's a bug.
If the problem is not covered under the preceding topics you may have discovered a
problem in the manual or in the software.  In either case, we would like to know about
it.  Please convey the circumstances and problem back to us.

Hardware and Software Requirements

µGCK requires a Mac Plus or later Macintosh computer running System 6.0 or later.  To
tell what system you are running, choose the About the Finder item from the   menu
of the Finder program.  The Finder program is where you start out, before you run a
program like µGCK.
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